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Pyxis Commander Software 

Quick Start Guide for Installation and Configuration 

Optec software engineers have developed a single unified 

driver for all versions of the Pyxis camera field rotators.  

Whether you’re using the original 2-inch Pyxis, Pyxis 3” 

first or second generation, Pyxis LE, or the new Pyxis 2” 

GEN3 rotator, you can now use Pyxis Commander 

software to control one or more of these devices from 

multiple clients.  

Pyxis Universal Driver 

Introducing CrossCom 
Built with Optec’s new CrossCom architecture, you can 

use the Pyxis Commander software to control rotators 

using Windows, Mac OS, or Linux.  For best compatibility 

Windows 7, 8, and 10 users will configure Pyxis 

Commander as an ASCOM local server  which allows 

multiple clients to share access to the hardware level 

drivers.   

CrossCom works on a layer just below ASCOM and SBIG’s 

X2 standards to allow control through nearly any device.  

Simultaneous rotator access is allowed on any OS 

assuming the connection link is valid and accessible.   

 

Download and Install 
Visit Optec’s download page to download the most recent version of Pyxis Commander Software and 

Unified Driver: 

http://www.optecinc.com/astronomy/downloads/pyxis.htm  

http://www.optecinc.com/
file://///Epsilon/data/Office%20Files/PRICES/Optec%20Prices%20and%20Terms/www.optec.us
http://www.optecinc.com/astronomy/downloads/pyxis.htm
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Once downloaded, open the zip file and click Setup.exe to begin the installation.  Follow the onscreen 

instructions until setup completes.   

For Windows users, ASCOM platform 6.1 or higher and .NET platform 4.0 are required.  The Pyxis  

ASCOM components should be installed automatically.  Locate and click Pyxis Commander (Start – All 

Programs – Optec – Pyxis Commander – Pyxis Commander.exe) to start the Commander program for 

configuration and control. 

 

Configure Device Type and Instance  
Click Tools – Settings to begin the configuration.  For first time setup you will see an Add New Driver 

Instance dialog box.   Select your correct Pyxis type from the Device Type: pulldown.   

 Optec Pyxis Gen 1 - Pyxis 2” and Pyxis 3” 

Gen 1 or Gen 2.  These rotators feature 

serial communication only including 

Optec’s USB/Serial cable. 

 Optec Pyxis Gen 3 - the Pyxis 3 ” Gen3 third 

generation rotator features a dual control 

circuit for USB/Serial or Ethernet 

connections. 

 Optec Pyxis LE – Pyxis LE rotator with true 

USB connectivity.  

Be sure to select the correct device type and click the Ok button.  You will see the main Pyxis Universal 

Driver Setup dialog box.  Note the Driver Instance number (default = 0) is displayed in the dialog box 

header.   If you have multiple Pyxis Commander drivers in use, each will be assigned a unique ID.   

If you configure additional Pyxis rotators of the same device type, each will also be assigned a unique 

instance ID.  Each configured Pyxis rotator will appear as a tab in the Pyxis Universal Driver Setup dialog 

box.   However, if you have just one rotator in your system we suggest you configure and use just that 

one instance.   It will be the default for all ASCOM client configurations as well as Pyxis Commander. 

http://www.optecinc.com/
file://///Epsilon/data/Office%20Files/PRICES/Optec%20Prices%20and%20Terms/www.optec.us
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Configuring Multiple Rotators 
If you have multiple rotators connected to your system you can configure each as desired.  In the Pyxis 

Universal Driver Setup dialog, click Device Options to add a new device.  You can also remove unused 

devices, use a selected device, or set one of the devices as your default.  Note that each new device 

instance will be assigned a 

unique ID as shown in the 

parenthesis.   

Click the tab to bring up the 

rotator device you wish to 

configure.  Click User 

selected device to select 

this device for use with 

Pyxis Commander or a 

higher level ASCOM client.   

You may also Make 

selected default so that it 

will be automatically 

selected whenever you 

configure a new client. 

 

Device Persistence 
Note that when you 

configure a Pyxis 

Commander instance or an 

ASCOM client, the selected 

device will be persistent.  

That is, you will not need to 

reset the device selection 

each time you open or use 

the ASCOM client. 

 

http://www.optecinc.com/
file://///Epsilon/data/Office%20Files/PRICES/Optec%20Prices%20and%20Terms/www.optec.us
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Configuration 

Configure ASCOM Clients 
Each ASCOM rotator client will look a bit different, but all share a common ASCOM Chooser interface.  In 

your client application, open the ASCOM Rotator Chooser dialog and select Optec Pyxis Universal 

Driver.   Click Properties… to open the Pyxis Universal Driver Setup dialog.  Note that the calling ASCOM 

client name will be displayed in the dialog box header.   

Click the desired tab 

corresponding to the 

rotator device and instance.  

Confirm a valid connection 

by clicking Connect and 

adjust any parameter as 

needed.  At the bottom, 

click Use selected device 

and then Exit to bind this 

instance to the ASCOM 

client.   

Click Ok in the ASCOM 

Chooser to return to the 

calling ASCOM client and 

confirm your connection.  Because the Pyxis Universal Driver is constructed as an ASCOM local server 

you can also connect simultaneously with Pyxis Commander or another ASCOM client.  However, for 

optimal performance we recommend limiting the simultaneous connected client list to no more than 

three higher level clients. 

Configure TheSkyX 
Software Bisque’s TheSky X Professional Edition (TSX) planetarium and observatory control software is 

widely used by astronomers and observatories across the globe.  On Windows platforms you can 

configure TSX as a standard ASCOM client similar to the procedures outlined above.   

To start the configuration, click the Rotator tab in TSX and click Rotator Setup…  Next, Choose Ascom – 

ASCOM Rotator and click OK.  Click Rotator Setup – Settings…  and you will see the ASCOM Chooser 

dialog.  Select Optec Pyxis Universal Driver and Properties.    

http://www.optecinc.com/
file://///Epsilon/data/Office%20Files/PRICES/Optec%20Prices%20and%20Terms/www.optec.us
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Click the desired tab corresponding to the rotator device and instance.  Confirm a valid connection by 

clicking Connect and adjust any parameter as needed.  At the bottom, click Use selected device and 

then Exit to bind this instance to the TheSky X ASCOM client.   

For Mac users or Windows users wishing to use the native X2 drivers rather than ASCOM, contact Optec 

Technical Support (support@optecinc.com) for additional instructions. 

Pyxis Commander Controls 
The Pyxis Commander interface has been designed for ease of use with simple straight forward controls.   

Click Help – Documentation for details explanations of the interface.  The View menu allows you to 

selective activate and de-activate the various controls to suit your interface preference.   Re-size to fit 

your desktop.  Click Home – Home Rotator to force the Pyxis rotator to perform a homing operation.   

Click Tools – Settings to configure devices and instances as described above.  Under the File menu you 

can Connect and Disconnect the rotator which will light up the red LED on the main form.  You can also 

click directly on the LED to toggle connection states.  Also under the File menu is the firmware upgrade 

wizard for the newer Pyxis 2” GEN3 rotators only.  Contact Optec Sales (sales@optecinc.com) to 

upgrade any of the 1st or 2nd generation Pyxis 2” or Pyxis 3” rotators. 

Sky PA vs. Instrumental PA 
There can be some confusion regarding the Sky Position Angle or Sky PA compared to Instrumental 

Position Angle.  Sky PA, in our context, refers to the rotation of an imaging camera on a telescope.  

Cameras oriented so that the resultant image exactly matches a star chart with the North Celestial Pole 

(NCP) at the top would be considered to have a Sky PA of 0 degrees.  Sky PA is always reported in 

degrees east of the NCP and can be easily measured by performing  a plate solution which calibrates an 

image plate scale and rotation angle to the actual sky.  See http://nova.astrometry.net/. 

Instrumental PA refers to the rotation angle of the Pyxis rotator that is not yet calibrated to match the 

actual Sky PA.   Performing a Home on any Pyxis will cause the rotator to move to the fixed stop point 

(usually Instrumental PA = 180 degrees), then turn around half-way to end at Instrumental PA = 0 

degrees.  Most users install the Pyxis and camera such that Instrumental PA is very nearly due north to 

correspond with the NCP (North Celestial Pole.  However, often the Sky PA and Instrumental PA differ by 

some amount which we define as the Sky PA offset.  Adding to the complexity, when using a German 

Equatorial Mount and performing a meridian flip, the camera’s Sky PA will be shifted by 180 degrees.  

However, the Instrumental PA will remain fixed.  Ideally, we wish to think in terms of Sky PA only. 

http://www.optecinc.com/
file://///Epsilon/data/Office%20Files/PRICES/Optec%20Prices%20and%20Terms/www.optec.us
mailto:support@optecinc.com
mailto:sales@optecinc.com
http://nova.astrometry.net/
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Set Sky PA  
The Set Sky PA button allows a user to enter the actual Sky PA from a plate-solve into the Pyxis 

Commander software.  The displayed PA and rotator indicator will immediately change to match the 

new value.  Simply click the button and 

enter the Sky PA from the plate solution 

results and click Set. Notice the Current 

Offset is displayed in the Set Sky PA dialog 

box at the bottom.  

IMPORTANT NOTE:  Because ASCOM does 

not support rotator offsets as a standard 

property, the Sky PA Offset will not be 

passed through to a higher level ASCOM 

client.  This can be a source of confusion 

for many users when setting or syncing an offset.  Optec recommends applying a position angle offset 

separately in each of your preferred ASCOM clients.  Typically, however, you will likely want to limit 

yourself to just one or two clients to avoid any confusion.   For example,  if TheSky X is your preferred 

client you should apply a Sky PA offset in that program  (see Rotate Using FOVI below) and then apply 

the offset separately in Pyxis Commander if you wish to also use our program user interface.   

With the current implementation of Pyxis Commander, only the Instrument PA is passed along the 

ASCOM driver to higher level clients.  The Sky PA offset is not passed along.   Also, the driver has no 

knowledge of additional offsets applied by higher level clients. 

Set Park 
Click the Set Park button to set the Instrumental PA where 

you wish to actually park the camera at the end of your 

imaging run.  Normally, you would not want this to change 

regardless of the Sky PA.  The Rotator Park Position dialog 

box allows you to set the current position as park or type in 

any desired Instrumental PA as the park position.  The 

Current Park Position is also displayed. 

  

http://www.optecinc.com/
file://///Epsilon/data/Office%20Files/PRICES/Optec%20Prices%20and%20Terms/www.optec.us
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Rotate Using FOVI 
Many client programs allow users to enter a Field of View Indicator 

or FOVI into the planetarium program.  In programs such as Maxim 

D/L and TheSky X, the FOVI can be used interactively.  That is, the 

FOVI can be used to select a desired guide star, for instance.  By 

grabbing and dragging the guide camera field to encompass a 

suitable guide star the planetarium program which is linked to the 

rotator will send suitable commands to the Pyxis drivers to adjust 

the Sky PA.    

The screen shot at left shows a FOVI within TSX.  Click on the grab 

handle (small square above the guide star box) and drag it to a bright guide star.  Upon releasing the 

handle, a dialog box will appear allowing you to “Send Command to Rotator”. Clicking OK here will move 

the Pyxis rotator to the desired position angle or Sky PA.   

Clicking “Adjust FOVI Position Angle” will instead apply a Sky PA offset to current position angle in TSX.  

IMPORTANT NOTE:  this offset will NOT be applied to the Pyxis Commander interface.  To keep the two 

programs in sync, you will need to also apply the same Sky PA offset in Pyxis Commander. 

Maxim D/L has a 

similar feature and 

functionality.  ACP 

allows pre-planning 

by selecting a guide 

star in a Scheduler 

application using 

planetarium 

software and a 

scripting interface.  

Other ASCOM 

clients and software 

applications may 

have similar 

features.  

http://www.optecinc.com/
file://///Epsilon/data/Office%20Files/PRICES/Optec%20Prices%20and%20Terms/www.optec.us
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Pyxis De-Rotation Software 
Users of Alt-Az mounted telescopes require de-rotation during 

imaging when exposures are longer than just a couple of minutes.  

Optec has developed a free application to use with any Pyxis 

rotator that acts as a shim between the ASCOM telescope and 

Pyxis drivers.   

This Alt-Az De-Rotation Server software reads the current 

telescope altitude and azimuth, calculates the current de-rotation 

rate, and applies that rate to the Pyxis rotator.  The software is 

easy to setup and functions whenever the telescope is not slewing 

and the rotator is not rotating to a new position.   

To learn more and to download the software, visit 

http://www.optecinc.com/astronomy/downloads/altaz_server.htm 

Additional Pyxis Information 
Visit the Optec website for the additional information describing and of our Pyxis rotators. Contact 

Optec support (support@optecinc.com) for help configuring any ASCOM client including Maxim D/L, 

ACP, CCD AutoPilot, Sequence Generator Pro, PhD2 Guide, as well as non-ASCOM software such as 

Software Bisque’s TheSky X. Our Resource page is may provide additional helpful information: 

http://www.optecinc.com/astronomy/resources.htm.  

Optec User Group 
The Optec User Group on Yahoo! can also provide answers to specific configuration questions and 

provides a forum to communicate with other users.  Click the banner below to subscribe. 

 

Or visit the Yahoo! site here:  https://groups.yahoo.com/neo/groups/Optec/info. 

http://www.optecinc.com/
file://///Epsilon/data/Office%20Files/PRICES/Optec%20Prices%20and%20Terms/www.optec.us
http://www.optecinc.com/astronomy/downloads/altaz_server.htm
mailto:support@optecinc.com
http://www.optecinc.com/astronomy/resources.htm
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